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Chapter 1

Editing

1.1 Typing And Editing
CONTENTS

This section of help will give advice on how
to create and change text and objects in your
documents:

Changing The Appearance of Text
Copying Or Moving Text And Objects
Drag and Drop Text Editing
Drawing A Line, Oval, or Box
Drawing Objects

Erasing Text And Objects
Finding And Replacing Text
Inserting or Creating An Object
Installing Additional Fonts
Repeating Your Last Command
Selecting Text And Objects
Typing Text Into Your Document
Undoing Your Last Action

Using Colours

You can insert different items into your
document to create lists or number pages:

Inserting A Foreign Character Or Special Symbol
Inserting A Header Or Footer

Inserting An Object

Inserting A Page Or Column Break

Inserting A Page Number Or Page Count

Inserting The Date And Time

Wordworth allows you to move through your
document in many ways:

Going To A Specific Part Of A Document
Moving The Insertion Point
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Wordworth has different tools to aid in the
construction of a document:

Getting Statistics About Your Document
Sorting Text

Spell Checking Your Document

Using Auto Correct

Using The Thesaurus

1.2 Typing And Editing
Changing The Appearance Of Text

You can change the appearance of your text by:
\textdegree{} Using a different font (design of character)
\textdegree{} Using a different size
\textdegree{} Applying a text style to the character
(italic, bold etc.)
\textdegree{} Using a different colour

These different methods can be applied by
using the menus , toolbar or ruler

To change the Font type, size, style or colour,
choose the Font command (Format menu).

From this requester you can change all the
styles of a font; you can also change its
Kerning (space between certain pairs of
letters), and Tracking (overall space between
letters).

The Font Format requester can be
displayed by selecting the ‘AZ’ icon on the
toolbar.

Using the Ruler you can change the Font by
selecting a different name from the Font
gadget. You can change the size of the font
by either typing a figure into the size
gadget or selecting from its pop up list.

Different text styles can be changed by
selecting one of the four buttons; P - Plain,
B - Bold, I - Italic and U - Underline.

You can also mix the styles of bold, italic
and underline.

To turn all styles off, select P for Plain text.

Alternatively, the text styles can be changed
from the Format menu.

Different background and text colours can be
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applied to any text from the Font command
(Format menu). See also: Using Colours

1.3 Typing And Editing

Copying Or Moving Text And Objects

You can copy and move text or objects using
the clipboard.

The following commands from the Edit menu
manipulate the clipboard and its contents:

\textdegree{} Cut — Delete selected text or object
and store it on the clipboard.

\textdegree{} Copy - Copy selected text or object to
the clipboard.

\textdegree{} Paste - Insert contents of the clipboard
at the insertion point.

\textdegree{} Erase — Erase the selected text or object.

Once text or objects have been placed on the
clipboard, you can repeatedly paste the
contents into the same document, or another
Wordworth document.

Using the keyboard:

\textdegree{} Right Amiga-X Cut selected text or
object to clipboard

\textdegree{} Right Amiga-C Copy selected text or
object to clipboard

\textdegree{} Right Amiga-V Paste clipboard contents
at insertion point

\textdegree{} Del Erase selection

\textdegree{} Backspace Erase selection

Using the toolbar:
Cut, Copy and Paste can also be selected
from the toolbar Dby clicking on
the appropriate icon.

The paragraph format can also be copied and
pasted to subsequent paragraphs by pressing
Right Amiga Shift-C and Right Amiga Shift-V.

Cutting and pasting Text Frame objects only
pastes the object and not the text inside.
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1.4 Typing And Editing

Erasing Text And Objects

You can erase any selected text or objects by
pressing either the Backspace or Del keys, or
choosing Erase (Edit menu) .

To erase text, you press the Del key to delete
the character to the right of the insertion
point, and the Backspace ‘<-’' key to delete
the character to the left.

If you wish to delete selections of text ,
highlight the text using the mouse select key
and either press the Del or Backspace keys, or
choose Erase (Edit menu) .

Any object can be deleted by selecting it
with the mouse pointer then pressing the Del
or Backspace key, or choosing Erase

(Edit menu) .

Groups of objects can be deleted by multiply
selecting the objects with the Shift key and
pressing the Del key.

1.5 Typing And Editing

Finding And Replacing Text

Choose Find command (Edit menu) to find and
replace occurrences of text with new text you
specify.

The Find requester may be left open whilst
editing the document.

To the left of the Find and "Replace With"
text gadgets, there are popup buttons (a
button with a triangle in it) which when
selected will display the previous entries.
The item you select from the popup list will
be placed into the text gadget for editing.

Special text codes, fonts, and styles may be
searched for and replaced by choosing from
Font pop-up to the right of the text gadget.

You can also find and replace styles of text
by selecting Font from the Font pop-up.
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Find Again

Choose "Find Again" (Edit menu) to find the
next occurrence of the text you specified
using the Find command.

NOTE: The Find and "Find Again" commands only
operate within the current text frame.

1.6 Typing And Editing

Repeat

Choose Repeat (Edit menu) to repeat the last
command from the Format menu.

This command is extremely useful for repeating
the last font or paragraph change, to other
selections of text.

1.7 Typing And Editing

Selecting Text And Objects

You can select any number of objects or text
with either the mouse or keyboard.

For information on how to the select objects with
the mouse or keyboard, see

Selecting And Sizing Objects , or on the
selection of text, see Selecting Text

1.8 Typing And Editing
Typing Text Into Your Document

To type text into your document, just activate
the main document page by clicking on it and
start typing.

Text frames need to be selected (by clicking on
them) before you can start typing in them.

Foreign Characters

The Amiga has a facility called ‘dead keys’ which
enable you to type foreign characters like & and
é.
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To do this, hold down the Left-Alt key and then
press one of the dead keys - F, G, H, J, or K.

The next letter that you type will then appear

with a foreign accent above it.

For example, if you press Left-Amiga K and then A,
the character a4 appears.

\textdegree{} dead key produces
\textdegree({} dead key produces '
\textdegree{} dead key produces *

\textdegree{}
\textdegree{}

dead key produces ~
dead key produces

N g m ™

1.9 Typing And Editing
Undoing Your Last Action

Choose Undo (Edit menu) or press Right Amiga-Z
to undo your previous deletion.

When not available, the Undo command will be
dimmed.

1.10 Typing And Editing

Using Colours

Wordworth uses ‘named colours’ which means that
you can define a certain colour to a defined name.
This new colour can then be used with the drawing
tools, objects or text.

Only colours in the list can be applied to
objects or text. If you need a colour that is not
in the 1list, simply define a new one.

If you are in a screen mode that only allows

8 colours for example, you may not see the

exact colour that you specified on the screen
because of the lack of available colours.
However, the document will always print using the
colours you specified and not those shown on
screen, which may be incorrect.

Colours can be defined from the Colours command

(Edit menu) or by selecting the Define entry in a
colour pop-up.

1.11 Typing And Editing
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Inserting A Foreign Character Or Special Symbol

To insert special characters, choose Insert
(Edit menu). Select Symbol from the list

click a foreign character or symbol to place it
into text gadget.

When you have chosen all of the characters you
wish to insert, click Insert to place the contents
of the text gadget into your document at the
insertion point.

See also
Typing Text Into Your Document

1.12 Typing And Editing

Inserting A Header Or Footer

To insert a header or footer on all pages click
the text frame at the top or bottom of the page.
The header or footer frame will then become
active, and a flashing cursor will appear for
you to type text.

To return to editing the main document, just
click the main document page.

Headers and Footers can be turned on or off from
the Document Options requester (Format menu) .

In a ‘facing pages’ document, different headers
and footers can be placed on left and right
pages by entering the appropriate text on either

page.
NOTE: You must have enough room in your header or
footer to contain the height of text you wish to
insert.

Ensure the "Top Margin" (Document Format) plus the

height of the characters is greater than the Header
margin (Document-Options) .

1.13 Typing And Editing

Inserting A Page Or Column Break

Wordworth automatically paginates your document
as you type past the end of a page and on to
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the next page.

You can manually paginate (before you get to the
bottom of the page) by choosing the Insert command
(Edit menu) and selecting "Page Break" from the
list.

Column breaks, moving onto the next column, can
be inserted by selecting "Column Break" from the
Insert command (Edit menu) .

1.14 Typing And Editing

Inserting The Page Number And Page Count

Choose Insert (Edit menu) and select
"Page Number" from the list to place the current
page number at the insertion point.

The Numbering style can be specified to
display the page number as a roman numeral,
a letter or a number.

The total page count can also be placed at the
insertion point by choosing Insert and selecting
the "Page Count" from the list. This is useful
for numbers such as ‘Page 1 of 15'".

NOTE: Page numbers and page counts can only be
inserted into headers or footers.

1.15 Typing And Editing

Inserting The Date And Time

Choose Insert (Edit menu) and select one of the
date or time options:

\textdegree{} Current Date - Inserts the current date at
the insertion point.

\textdegree{} Updating Date - Inserts a date command,
‘{-DATE-}’, at the insertion
point, which is replaced by
the current date at the time
of printing.

\textdegree{} Current Time - Inserts the current time at
the insertion point.

\textdegree{} Updating Time - Inserts a time command,
‘(-TIME-}’, at the
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insertion point, which is
replaced by the current time
at the time of printing.

The date and time format can be set from the Options
button on the "Document Format" requester (Document
command, Format menu) .

1.16 Typing And Editing

Going To A Specific Part Of A Document

Choose "Go To" command (Edit menu) to move to a
chosen page.

Just type the page number into the text gadget
and click "Go To".

1.17 Typing And Editing

Moving The Insertion Point

The insertion point can be moved by using the
cursor keys Up, Down, Left or Right.

You can also use the mouse to position the
pointer in the text and then click to place the
insertion point there.

1.18 Typing And Editing

Getting Statistics On Your Document

Choose Statistics (Tools menu) to display
information about your document. Divided into
two requesters, these contain:
Document name, directory path, description,
creation date, last saved date, by whom,
revision number, editing time, date of last
printout.

Text statistics include:
Number of - Characters, words, lines,
paragraphs, pages, pictures.

This information relates to all of the document,
or the currently selected text.
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1.19 Typing And Editing

Sorting Text

Block select the paragraphs you wish to sort and
choose Sort (Tools menu).

Select the sort order ( A-Z or Z-A ) and click
Sort. The paragraphs will be sorted
alphabetically on the text at the beginning

of each paragraph.

If you wish to sort a list of names or numbers,
then place each item on a new line (separated
by a carriage return) before sorting.

1.20 Typing And Editing

Using The Spell Checker

Choose "Spell Check" (Tools menu) to check
the spelling of the entire document from the
position of the insertion point, against the
English Collins dictionary.

To spell check a word, first select it and
then choose "Spell Check" (Tools menu) .

You can add a word to the User Dictionary by
clicking Learn from the "Spell Check" requester.

You can also add your own words, delete or edit
words in your User Dictionary, which
supplements the Collins Dictionary, by

choosing Spell from the Change Settings
command (Settings menu) .

NOTE: "Spell Check" only checks the words in the
current text frame.

1.21 Typing And Editing

Using Auto Correct

Choose "Auto Correct" (Tools menu) to
automatically replace commonly misspelt words.
You can then edit the words from the list. For

example, you may commonly misspell the word ‘the’
by transposing the two first letters, ‘hte’. This

mistake will be deleted by Wordworth as you type
and corrected automatically.




Editing

11/14

This command can also be used for abbreviations.
For example, if you typed ‘Digita International
Limited’ in your document many times, it would
be easier to add the words to the Auto Correct
list for ‘di’ to be replaced with ‘Digita
International Limited’.

Additionally, Auto Correct can be used to
automatically correct the capitalisation of the
days of the week, and months of a year.

1.22 Typing And Editing

Using The Thesaurus

Choose Thesaurus (Tools menu) to check synonyms
and parts of speech of a selected word against
the English Collins thesaurus.

The word closest to the insertion point will
automatically be used by the Thesaurus for its
first search. All previous searches in each

session are shown in the Word pop-up text gadget.

1.23 Typing And Editing

Drag And Drop Text Editing

Drag and Drop editing is the easiest way to move
or copy a selection of text in one operation.

To move text using Drag and Drop editing:
1. Select the text you wish to move

2. Point to the selected text and then hold down
the Selection button.

When the Drag and Drop pointer appears (a
pointer with a grey box beneath it), drag the
dotted insertion point that appears in the
text, to the new location.

3. Release the Selection button to drop the text
in place.
To copy text using Drag and Drop editing:

1. Select the text you wish to copy

2. Point to the selected text, hold down the
Selection button and depress the Ctrl key.




Editing 12/14

When the Drag and Drop pointer appears (a
pointer with a grey box beneath it and a plus
sign in the corner), drag the dotted
insertion point that appears in the text, to
the new location.

3. Release the Selection button to drop the text
in place.

Drag and Drop can be turned on and off from the
Text Settings requester ("Change Settings"
command, Settings menu) .

Drag and Drop usually works best if you set the
Workbench Input preferences to use a smaller
‘Double—-click Delay’.

1.24 Typing And Editing

Installing Additional Fonts

There are two methods to install additional
Agfa Compugraphic or Outline fonts:

1. Copy the appropriate font files into the
Intellifont drawer which are within the WwFonts
drawer.
\textdegree{} Agfa Intellifont font files will be suffixed
by ‘.type’ or ‘.1lib’,

NOTE: The WwFonts drawer is located in the
Wordworth3 drawer on your hard disk, or on the
Ww30Outlines disk if you are running from
floppy disk.

To install the fonts that you have Jjust
copied, double-click the ‘InstallOutlines’
tool (WwTools drawer).

NOTE: The WwTools drawer is located in the
Wordworth3 drawer on your hard disk, or on
the Ww3System disk if you are running from
floppy disk.

2. Select the ‘InstallOutlines’ tool, which is
located in the WwTools drawer, and choose
Information from the Workbench-Icons menu.

On the Information requester, there is a list
of ‘Tool Types’, these Tool Types are used to
tell the tool which fonts to install for
Wordworth 3.




Editing

13/14

For example, if you have some fonts on a

separate disk called ‘CGFonts_1’, click New on

the Information requester and type
‘FONTPATH=CGFonts_1:".

Press Return and click Save (the colon ‘:’ is

used to tell the Amiga that you are looking for

a disk).

Double-click the ‘InstallOutlines’ tool to
install the fonts on this disk for use with
Wordworth.

IMPORTANT

Only one ‘FONTPATH’ Tool Type should be enabled
when installing. To disable a Tool Type you
should place brackets around the string.

Many Tool Types have already been added to the
Information requester for the most common font
disks, therefore select the one that is most
appropriate and delete the brackets. Press
Return, click Save, and double-click to install.

Example Scenarios:

A.

I am using a hard disk and I have Wordworth
Special Edition. I wish to use the fonts
supplied with my old version of Wordworth with
the new Wordworth 3.

I am, however, going to delete the Special
Edition version off my hard disk afterwards.
You will need to follow step 1 above -

Open up your ‘Wordworth Special Edition’
Intellifont drawer and choose the

‘Show — All Files’ command from the Workbench
Windows menu.

Next, open up the Wordworth 3 WwFonts drawer,

and for each of the font files ending in ‘.type’,

select and drop the file onto the Wordworth 3
Intellifont drawer.

Finally, to install the fonts you have just
copied to Wordworth 3, double-click the
‘InstallOutlines’” tool which you will

find in the WwTools drawer on your hard disk.

I want to use the AgfaFonts disks that came
with Wordworth 2, with Wordworth 3. I am
running Wordworth from floppy disks.
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Firstly, you will need to make new backup copies
of your original AgfaFontsl and AgfaFonts2
disks.

Next, select the ‘InstallOutlines’ tool, which
is located in the WwTools drawer on the
Ww3System disk, and select the Tool Type which
says ‘(FONTPATH=AgfaFontsl:Intellifont)’.

The tool type should then appear in the text
gadget beneath the list. Delete the brackets
at the beginning and end of the string and
press Return.

Click Save and then double-click the tool to
install the fonts on the AgfaFontsl disk for
use with Wordworth 3.

To install the fonts on AgfaFonts2, select the
tool type you have just changed and type
brackets around the string.

Select the tool type with the text

‘' (FONTPATH=AgfaFonts2:Intellifont)’ and delete
the brackets. Press Return and double-click
‘InstallOutlines’ to install.
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